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Summary 

The Navy Computer-Assisted Medical Diagnosis (NCAMD) system is designed to assist 
Independent Duty Corpsmen (IDCs) in rendering a medical diagnosis. The NCAMD system was 
written using Microsoft FoxPro, Version 2.0, database management system. For each encounter 
the signs, symptoms, and laboratory information collected can be gathered on data entry forms 
created for NCAMD or entered directly (real time) into the system. A Chronological Record of 
Medical Care (SF600) can be generated automatically to document the encounter. 

The NCAMD system User's Guide was written to familiarize the IDCs with the NCAMD 
software. The keyboard and mouse commands necessary to run the various options are explained 
in conjunction with the associated screens. 
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Section 1  Introduction 

1.1 Purpose of the Navy Computer-Assisted Medical Diagnosis (NCAMD) System User's 
Guide. The purpose of the user's guide is to provide Independent Duty Corpsmen (IDCs) with 
the information necessary to effectively use NCAMD. In this user's guide, the basic structure 
and features of the NCAMD system will be explained. 

1.2 Navy Computer-Assisted Medical Diagnosis (NCAMD). Medical care on board many 
small ships and submarines is the responsibility of IDCs. These vessels often operate in remote 
areas where IDCs cannot easily obtain consultations. Therefore, the Navy Medical Research and 
Development Command (NMRDC) initiated a program to develop a set of diagnostic algorithms 
that could be automated.  The objectives of this effort are to: 

• Provide medical practitioners with accurate medical diagnostic and treatment 
information 

• Prevent unnecessary, hazardous, and disruptive medical evacuations by providing 
diagnostic assistance to IDCs 

• Improve communications between isolated IDCs and their supporting medical 
officers by providing a standardized method for information collection 

• Gather clinical information in a modifiable diagnostic knowledge base to ensure 
diagnostic accuracy 

1.3 References. The following references are provided as technical and background 
information. 

• FoxPro Commands and Functions (1991). Fox Software, Inc. Perrysburg, Ohio. 

ICD-9 CM,   International Classification of Diseases 9th Revision (1980).   U.S. 
Department of Health and Human Services. 

• Abdominal Pain - A Decision Support System for the Management of Acute 
Abdominal Pain, Version 3.0, Programmer's Manual (1989). Naval Submarine 
Medical Research Laboratory Technical Report No. 1148; Groton, CN. 

• Chest Pain - A Decision Support System for the Management of Acute Chest 
Pain, Version 3.0, Programmer's Manual (1989). Naval Submarine Medical 
Research Laboratory Technical Report No. 1149; Groton, CN. 
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1.4      Terms and Abbreviations. 

Carriage Return <CR>. Notation used to denote a carriage return typically 
executed by pressing the <ENTER> or <RETURN> key on a computer keyboard. 
If a mouse is available on the computer system, "click" or press the top left button 
for a return. 

Database Management (DBM). A management approach to database design 
consisting of what information is collected, where it is stored, and how it is 
processed by computer software. 

Default. A response assumed by NCAMD. If the default value is correct, the 
user need only press the <ENTER> or <RETURN> key. 

Expert System. A computer program that emulates the behavior of a human 
expert in a specific area of knowledge. 

FoxPro. A database management development system written by the Fox 
Software, Inc. FoxPro, Version 2.0, was used to develop the NCAMD system. 

NCAMD.  Navy Computer-Assisted Medical Diagnosis. 

SAMS. SNAPS Automated Medical System, Version 7.0, is a FoxPro software 
application for handling shipboard medical department forms, files and data. 

SNAPS.   Shipboard Non-tactical ADP Program. 

System. The combination of hardware, firmware, and software designed to 
function as an integrated unit. 

SF600. The Chronological Record of Medical Care standardized form used for 
documenting a medical encounter. 

Computer-Assisted Medical Diagnosis 



Section 2 System Summary 

2.1 System Application. IDCs provide medical services on many U.S. Navy submarines and 
small surface ships. To assist the corpsmen and enhance their diagnostic skills, the U.S. Navy 
has initiated the development of the NCAMD system. 

2.2 Programming Language. The NCAMD software was written in the FoxPro, Version 2.0, 
programming language. FoxPro is a DBM system created for the personal computer to produce 
computer applications. 

2.3 Security/Privacy. The security module will maintain user passwords allowing log-on 
access to NCAMD and its database files. Menu options are assigned to the user through a 
security key system in FoxPro. NCAMD collects and stores data covered under the 1974 Privacy 
Act. 

2.4 Flexibility. Since NCAMD was created by using the FoxPro utilities, enhancements and 
updates to the system can be accomplished with minimal programming. NCAMD was design to 
compatible with SAMS. 

2.5 Maintenance. The primary maintenance functions consist of security options, file and 
format definitions, user file updates, knowledge base editing, and initialization of data. 

2.6 "Too Many Files Open" Error Message. If the "Too many files open" message occurs, 
the following window will open. Select <CanceI> to end the program and return to the root 
directory (cd c:\). Modify the CONFIG.SYS by adding or editing the FILES command to a 
minimum of 50 files  (FILES = 50). 

Too Many Files  Open 

<Cancel>     <Ignore> 

Figure 1.  Error Message 

2.7 "Out of Environment Space" Message. If an "Out of Environment Space" Message 
occurs, change the CONFIG.SYS file. Return to the root directory (cd c:\) and modify the 
CONFIG.SYS by adding the SHELL command. The "/P" will make it permanent and the 
"E/:(size)" will expand the environment space from the default of 160 bytes. Reboot the system 
after changing the CONFIG.SYS. 

SHELL=COMMAND.COM /P /E:512 (DOS Version 3.2 and above) 
SHELL=COMMAND.COM /P /E:32  (DOS Version 3.1 and below) 
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2.8 System Organization. The system has 5 main menus which are (1) System, (2) File, 
(3) Edit, (4) Diagnosis, and (5) Window. Accessing the system requires a password (see Section 
3).  Once the password is successfully entered, the top menu, shown in Figure 2, will appear. 

System File Edit Diagnosis Window 

Navy Computer-Assisted Medical  Diagnosis   (NCAMD) 
Version 2.0 

Naval  Health Research  Center 
San Diego,   CA 

Press  the <Fl> key for help 

Figure 2. Main Menu 

2.9       Menu Options.   All NCAMD system options are shown in Figure 3. The system is 
operated using either a mouse or the keyboard to select these options. 

System File Edit Diagnosis Window 

Help ... Fl Reindex 
Quit 

Undo 
Redo 

Register Patient 
Encounter 

Cycle AF1 

Change Password 
Backup 
Restore 

Cut 
Copy 
Paste 
Clear 

Disease/Treatment 
Lookup 

SF600 Report 

Color 

Calculator 
Calendar/Diary 

Select All Training Mode 

Goto Line 

Figure 3. Menu Options 
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Section 3   Accessing the System 

3.1 Entering NCAMD (Log-On). Change the current directory to NCAMD or the one in 
which NCAMD was installed on the system (c:\CAMD). At the MS-DOS prompt, type CAMD 
and the following security prompt will be displayed. 

Unauthorized    access   to     this     United    States     Government 
Computer System and/or software is prohibited by Title 18, 
United States Code,   Section 1030.   This system may only be 
used for unclassified official  business. 

Enter Password: 

Figure 4. Log-On Screen 

Type in the password and <CR>. After an acceptable password has been entered a brief 
greeting will be shown. 

Computer-Assisted Medical  Diagnosis 

If you have any problems  or questions,   please  contact. 
Ms.   Hoa  L.   Ly 

Naval  Health Research  Center 
P.O.   Box 85122 

San Diego,   CA 92186-85122 
DSN 553-8401   or Com   (619)   553-8401 

E-mail:   ly@nhrc.navy.mil 

Press any key to continue. 

Figure 5. Greeting Screen 
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Navy Computer-Assisted Medical  Diagnosis   (NCAMD) 

The Navy Computer-Assisted Medical Diagnosis (NCAMD) 
system contains disease descriptions, diagnostic assistance, 
and treatment recommendations. Only the most common diseases 
in each category are considered for medical diagnosis. The 
nonspecific disease in each area represents nonsurgical, 
nonlife-threatening cases, which in general do not require 
evacuation. 

YOUR   JUDGMENT  MUST   TAKE   PRECEDENCE. 
cannot  make   the     subjective  evaluations 
important  in medical  diagnosis. 

The  NCAMD     system 
that   are   often  so 

The  <F1> key will  give additional  help 

Press any key to  continue   ... 

Figure 6. Greeting Screen Continued 

3.2      Exiting the NCAMD (Log-Off).  Choose <Quit> from File options to exit NCAMD. 

System File 
Reindex 
Cuxfc 

Edit Diagnosis Window 

If any windows are left  open   the  following window will  appear: 

Windows are still   opened. 
Do you want   to close  them? 

<YES> <N0> 

Figure 7.  File Options 
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3.3      Mouse Techniques 

Point.   Position the pointer (arrow) at the specific location on the screen.   The 
pointer moves in the same direction as the mouse. 

Click.  Point to an object, then press and release the mouse button once. 

Double Click.  Point to an object, then press and release the mouse button twice 
in rapid succession. 

Drag.   Hold the mouse button down, roll the mouse until the pointer is in the 
desired location, and release the mouse button. 

3.4      Choosing Menu Options 

Menu 
Bar 

Keyboard. Use the <Alt> key in conjunction with the highlighted letter of the 
menu pad. To access the File menu option, for example, press <Alt> <F>, then 
press <CR>. 

Mouse.   Point to the menu pad and press the left mouse button to display the 
menu popup window. Point to the desired option and press the left mouse button. 

Menu Pad 
i 

System File Edit                               ^Diagnosis Windows 
Menu Popup— * Reindex 

* — Menu Option Quit 

Figure 8.  Menu Popup Window 

Computer-Assisted Medical Diagnosis 



3.5       Dialogs. Dialogs are special boxes for data entry that allow the user to choose the action 
about to take place. 

Backup CAMD database: 

[DOC] 
CAMD9202.ZIP 

Scrolling List 

Drive 

Directory CAMD 

Popup 
button 

«Backup»    -— Default push button 
<Cancel>    <— Push button 

Backup Filename: 

Text Box 

Description  of Backup Files: Zoom Arrows 

Text Editing Box 

Figure 9.  Example of Dialog Boxes 

3.5.1 Scrolling a List 

• Keyboard. Use the arrow keys o> or <▼> to select an option, then press <CR>. 

• Mouse. Click on the up or down arrow on the scroll bar. Then holding down the 
mouse button on either arrow will cause the scrolling to continue until released. 

3.5.2 Choosing an Option on a Popup 

Keyboard. Press the <Tab> key to the popup control. Then press <CR> to open 
the window.  Choose an using the arrow keys, and press <CR>. 

• Mouse.   Point to the popup control and press the mouse button to display the 
popup. Drag to the desired option, then release the mouse button. 

Computer-Assisted Medical Diagnosis ■   8 



3.5.3 Choosing a Check Box, Radio Button, or Push Button 

• Keyboard. Press the <Tab> key to move the cursor to a check box, radio button, 
or push button, then press <CR>. 

• Mouse.   Point to a check box, radio button, or push button, then press the left 
mouse button. 

3.5.4 Text Editing Box. The text editor allows the user to type and modify information 
displayed in a region of the screen (e.g., Treatment or SF600 Report). When text editing, use 
the cursor to move through the text. The cursor looks like a flashing underscore, when in the 
insert mode, and a flashing box when in the overwrite mode. Press the <Insert> key to switch 
between modes. It is easy to move the cursor through text using 8 basic keys. Four of these keys 
can also be used in combination with a modifier key <Ctrl> to move the cursor a greater 
distance.  See Appendix A for the table of Text Editor Commands. 

3.5.5 Zoom Arrows 

• Keyboard.  To increase (A) or reduce (▼) the box size <Tab> to the appropriate 
arrow, and press <CR>. 

• Mouse.  Point to the desired arrow and click. 
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Section 4 System Transactions 

4.1 System Menu. To access the top level menu options using the mouse, point to the option 
and click. To use the keyboard press down the alternate function key and the first letter of the 
option (e.g., enter <AltxS> to access the System menu. The System menu options are used for 
file maintenance and desk accessories. 

System File Edit Diagnosis Window 

Help...Fl 

Change Password 
Backup 
Restore 

Calculator 
Calendar/Diary- 

Figure 10. System Menu Options 

4.1.1 Help <F1>. On-line assistance can be obtained by pressing the <F1> key at any time. 
NCAMD provides context-sensitive help that can be accessed by pressing <F1> or selecting the 
<Help> option on the System menu. 

DATA  ENTRY 
REGISTER  PATIENT 
PATIENT DETAILS 
Systolic 
Temperature 
Urinary 

I 

<HELP> 

Figure 11.  Help Topics Window 
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For more details on a particular topic, select the «Topics» button and press <CR>. 
To see information about the following topic in the system, choose <Next>. To see information 
about the previous topic, choose <Previous>. The <Look Up> and See Also functions are not 
used by the NCAMD system. To close the <HELP> window using the keyboard press the 
escape <ESC> key. To close it using the mouse, point to the small white rectangle in the top 
left corner of the window and click. 

« Topics » 

< Next     > 

<Previous> 

< Look Up> 

See Also 

Help 

Choose  the  item you wish  to run  from  the menu. Use  the cursor Up or 
Down arrow keys  to highlight   the desired item, then print  <Enter> 
to select  it.   For  the NCAMD diagnostic module, the  following 
choices are available: 

1. Register Patient. This option allows you to register a patient, 
review existing patients records, or select a patient for a medical 
encounter. The selected patient record is opened for the encounter 
described in  Option  2 below. 

2. Patient Encounter.     This option allows you   to  create a patient 
encounter,   register a patient,   or enter encounter details, 
including all  of  the relevant  signs and symptoms. 

Figure 12. Help Detail Window 

4.1.2 Change Password. This option lets the user to change the password. When Change 
Password option is chosen from the System menu, type a new password and press <CR>. 
Remember this change is permanent, so memorize the new password or make a notation and 
place it somewhere safe. 

Enter Password: 

Figure 13.  Change Password 
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4.1.3 Backup. The Backup option is used to copy the database to another file. Select the 
drive and directory where the file is to be stored, enter a name for the backup file, and select the 
«Backup» button. The system will automatically begin this process and display a message 
when finished. In Figure 14, the backup file was named CAMD9503.BCK. The 9503 represents 
the year and month in which the files were saved. 

Backup CAMD database: 

[DOC]                              1 
CAMD9502.BCK 

I 
»                               Dri ve c 

1                               Directory CAMD 

r 
« Backup » 
< Cancel  > 

Backup Filename:     CAMD9503.BCK 

Figure 14. Backup Screen 

4.1.4 Restore. This option allows the user to restore or reinstall the database previously backed 
up by the NCAMD system. To restore a backup file, enter the disk drive and directory where the 
backup file was stored, enter the name of the file, and select the «Restore» button. The 
system will automatically begin this process and display a message when finished. 

Restore CAMD database: 

[DOC] 
CAMD9502.BCK 
CAMD9503.BCK 

■ 

I 
1                               Drive C 

1                             Directory CAMD 

r 
I 

«Restore» 
<Cancel> 

Re ='Store Filename:     Ci MSD9503.BCK 

Figure 15. Restore Screen 
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4.1.5 Calculator. When the user chooses the Calculator option from the System menu, a 
graphic of a calculator appears on the screen. This calculator used like a standard pocket 
calculator and can be used by keyboard or the mouse. To use the mouse, simply click on the 
appropriate numbers and symbols on the calculator. With the keyboard, type the equation as it 
would be written.  Most calculator keys have the same keyboard equivalents. 

Keyboard 

Q 
R 
N 
A 
Z 
S 

Calculator 

V 
MR 
+ 

M+ 
MC 

M- 

MC 7 8 9 /    V 

MR 4 5 6 * i 

M+ 1 2 3 c 

M- 0 ± + 

Figure 16.   Calculator 

4.1.6 Calendar/Diary. When the user chooses the Calendar/Diary option from the System 
menu, a monthly calendar appears with the current day selected. This calendar is used just like 
any other calendar to check dates and keep track of appointments. Once it has been used, the 
default then becomes the last day selected.  To close this menu option, press <ESC>. 

Su       Mo 
August  95 
Tu       We       Th Fr Sa 

Diary 

1 

2 3 4 5 6 7 8 

9 10 11 12 13 14 15 

16 n 18 19 20 21 22 

23 24 25 26 21 28 29 

30 31 

< <- M > < M —> > < 4— Y > <   Y —» >  <Today> 

Figure 17.  Calendar/Diary 
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To the right of the Calendar panel is the Diary panel. Use the Diary panel to input text 
associated with any date on the calendar panel. To activate the Diary panel, press <Tab> or 
choose Diary from Diary menu. To activate the Calendar panel, press <shift><Tab> or choose 
Calendar from the Diary menu. 

4.2      File Menu. The File menu contains options for manipulating data files. Currently there 
are only two options on this menu: Reindex and Quit. 

System File Edit                                1  Diagnosis                        1   Window 

Reindex 

Quit 

Figure 18. File Menu 

• Reindex. This option is used to reindex or sort the database files. When the user 
chooses the Reindex option from File menu, a brief message will be displayed. 
The window will disappear when the task is completed. 

• Quit. The Quit option ends current NCAMD session. When chosen, a message 
will be shown on the screen, and will return to the MS-DOS prompt (c:\CAMD). 

4.3      Edit Menu.   The Edit menu options are used from within the Diagnosis menu, when 
editing the treatment section of an encounter or a SF600 form. 

System |   File Edit Diagnosis |  Window    | 
Undo 
Redo 
Cut 
Copy 
Paste 
Clear 
Select All 
Goto Line... 

Figure 19. Edit Menu 

Undo. Reverses the last action that was performed while text editing. Selecting 
the Undo option repeatedly will reverse all entries made during the current editing 
session. 

Redo. This is the opposite of Undo. Choose Redo to restore the text to its 
previous condition. Selecting this option will reverse the Undo option. 

Computer-As sis ted Medical Diagnosis 14 



Cut.    Removes selected text from any field, record, or text editing field. 

Copy.    Duplicates the selected text and places it on the clipboard. 

Paste. Inserts a copy of the clipboard contents into the current file, field, or text 
editing window at the cursor location. It will replace the contents of the clipboard 
with the selected text. 

Clear. Permanently removes selected text without placing it on the clipboard. 
If the user chooses this option when text is selected, the result is the same as 
pressing the <Del> or backspace keys. Additionally, the Clear option is used to 
erase a window or the desk top. 

Select All.    All lines of text in the current editing window are selected. 

Goto Line. Displays the «Goto» dialog box shown below. When this option 
is chosen, the cursor moves to the beginning of the specified line, and the text line 
is displayed in the window. If the line number specified is greater than the number 
of lines in the window, the cursor is positioned on the last line. 

Line Number: 
«     Goto     » Cancel 

Figure 20. Goto Line Dialog 

4.4 Diagnosis Top Menu Option. Currently, NCAMD has 3 diagnostic modules: Abdominal 
Pain, Chest Pain, and Ocular Pain. Each area has its own medical diagnosis, disease, and 
treatment databases. The diagnosis data is grouped by disease categories, in which only the most 
common diseases are considered. The Diagnosis menu is the main menu for NCAMD, see 
Appendix B. for examples of encounter forms for the Chest Pain and Abdominal Pain Modules. 

System File Edit Diagnosis 

Register Patient 
Encounter 
Disease/Treatment Lookup 
SF600 Report 
Training Mode 

Window 

Figure 21. Diagnosis Menu 
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4.4.1 Register Patient. When the Register Patient option is selected a patient selection 
window opens (see Figure 23). The patient database can be searched using complete or partial 
names or social security numbers. A question mark <?> can be used as a wild card character. 
After the information is entered, select the <Browse> button to search for a patient. When using 
the keyboard press <Tab> until the cursor is located on top of the button, then press <CR>. 

System                   File                         Edit Diagnosis Window 

Register Patient 
Encounter 
Disease/Treatment Lookup 
SF600 Report 
Training Mode 

Figure 22. Register Patient 

Social  Security: 

Last Name: 

First Name: 

PATIENT     SELECTION 

2222 

«  OK »     < BROWSE  >     <  CANCEL  > 

Figure 23. Patient Selection Window 

When the candidate list is displayed, the user has the option to <Select>, <Edit>, <New>, 
<SAMS>, or <Cancel>. Selection allows the user to choose a patient and continue entering the 
encounter. The <Edit> option is used when the user wants to change information that is 
contained in the file, such as last name. If the patient is not found in the candidate list, <New> 
allows the user the enter the patient into the lookup file. Another option with NCAMD is the 
interface to the SAMS. If the patient is registered in SAMS, the <SAMS> option will copy this 
information into the NCAMD system.  The <Cancel> function is used to abort the process. 

Select  from  the following candidates: 

000-00-2222                               DOE,   JOHN 
222-22-2222                               FLINTSTONE,   FRED 

<Select>    <Edit>       <New>    <Sams>    <Cancel> 

Figure 24. Candidate List 
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The Patient Enter/Edit window is called from the previous window in Figure 24. It is 
displayed when the user selects <New>, <Edit>, <SAMS>, or when the patient cannot be found. 
After the data are entered the user either selects <OK> to save the record or <CANCEL> to 
abort the process. 

Patient Enter/Edit 

Social   Security :      000   -   00   -   2222 

Last  Name: DOE 

First Name: JOHN 

Middle  Initial: A 

Date  of Birth: 07/13/65 

Sex: M 

Rate/Rank: HM1 

« OK     »            <  CANCEL  > 

Figure 25.  Patient Enter/Edit Window 

4.4.2 Encounter. After the Encounter option is selected from the Diagnosis menu, the patient 
Seek Function will be executed. If there is a pending encounter on the current patient, the 
system will prompt to <Resume> the current encounter, create a <New> encounter for the same 
complaint, or to <Cancel> this session. 

System                |   File                     |   Edit Diagnosis Window 

Register Patient 
Encounter 
Disease/Treatment Lookup 
SF600 Report 
Training Mode 

Figure 26. Encounter Option 
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Syster ti File  Edit Diagnosis  Window 

rtuiuj-iiy rjiiLuuiiteis 

Patient  000002222 
Date    09/28/95 

10:02:32 Acute abdominal pain 

<Resume>    < New >   <Cancel> 

Press the <F1> key for help 

Figure 27.  Pending Encounter 

If the <New> screen is chosen, the screen shown in Figure 28 will appear. 

System File  Edit  Diagnosis  Window 
Patient Encounter1 

Date 09/28/95  Time 10:02  Status P     Provider 
Patient Name DOE First JOHN 
SSN 000-00-2222 Sex M       Age 30 

<Complaint> <Diagnosis> 
<Symptom>- ■<Assist>- 

■<Explanation>- 
■<Treatment>- 

«Save» <Cancel> 

Data contained herein are subject to the Privacy Act of 1974. 
Afford protection in accordance with SECNAVINST 5211.5C. 

Figure 28.  Patient Encounter Screen 
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For a new encounter, the first button to be selected is <Complaint>. When the complaint 
button is activated the following window will appear: 

System File Edit Diagnosis Window 
Patient Encounter= 

Date 09/28/95  Time 10:02  Status P 
Patient Name DOE 
SSN 000-00-2222 Sex M 

Provider 
First JOHN 
Age 30 

<Complaint> <Diagnosis> 
:Complaints      = 

Acute abdominal pain 
Acute chest pain 
Acute ocular pain 
Head or spine injury 

<Select> 

<Cancel> 

Figure 29. Complaint Window 

Once the complaint has been entered, the symptom information can be added. Notice that 
the first information in the symptom window is age. If this were a pending encounter, some of 
the symptom information already may have been entered. Select the <Symptom> button to 
continue entering information. 

System  File  Edit  Diagnosis  Window 
=Patient Encounter= 

Date 09/28/95  Time 10:02  Status P     Provider 
Patient Name DOE First JOHN 
SSN 000-00-2222 Sex M       Age 30 

<Complaint>  Acute Abdominal Fain <Diagnosis> 

  <Symptom> 1 i <Assist>- 

■<Explanation>- 
■<Treatment>■ 

<Print>     «Save»   <Cancel> 

Figure 30. Symptom Window 
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When the <Symptom> button is selected the question window will open. After 
answering the question, either select <OK> to accept the answer or <Cancel>. Cancel will stop 
the question-and-answer session. 

System File Edit Diagnosis Window 
:Patient Encounter= 

Date 09/28/95  Time 10:02  Status P 
Patient Nr 
SSN 000 

<Complain 

Provider 

AGE 

Which of the following best describes the Site of 
the pain at ONSET 

] RIGHT UPPER QUAD 
] LEFT UPPER QUAD 
] RIGHT LOWER QUAD 
] LEFT LOWER QUAD 
] UPPER HALF 
] LOWER HALF 
] RIGHT HALF 

] LEFT HALF 
] CENTRAL 
] GENERAL 
] RIGHT FLANK 
] LEFT FLANK 
] NO PAIN AT ONSET 

< OK > <Cancel> 

Figure 31. Question Window 

Use the <Diagnosis> button to open the Disease window after all of the questions have 
been answered. Notice that the Disease window has 3 options that allow the user to <Select> 
the marked diagnosis; <View> a description of the marked diagnosis, or <Cancel>. 

System File  Edit  Diagnosis  Window 
Patient Encounter1 

Status P Provider 
First JOHN 

Date 09/28/95  Time 10:02 
Patient Name DOE 
SSN 000-00-2222 
<Complaint> Acute abdominal pain     <Diagnosis> 

Diseases on File = 

APPENDICITIS 
NONSPECIFIC ABDOMINAL PAIN 
RENAL COLIC 
PERFORATED DUODENAL ULCER 
CHOLECYSTITIS 
SMALL BOWEL OBSTRUCTION 
PEPTIC ULCER DISEASE 
MESENTERIC ADENITIS 
DIVERTICULITIS 

<Select> < View >   <Cancel> 

sist>- 

Figure 32. Disease File 
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Once the diagnosis is entered, select the <Assist> button for the computer to compute a 
diagnosis. 

System File  Edit Diagnosis Window 
= Patient Encounter1 

Date 09/28/95  Time 10:02  Status P     Provider 1 
Patient Name DOE First JOHN 
SSN 000-00-2222 Sex M       Age 30 

<Complaint>  Acute Abdominal Fain <Diagnosis> APPENDICITIS 

  <Symptom> 1 i <Assist>- 

AGE = > 30 
SITE AT ONSET = 
SITE AT PRESENT = 
NAUSEA 

■ <Explanation>- 
■<Treatment>■ 

<Print> <<Save» <Cancel> 

Figure 33. Assist Window 

While NCAMD is analyzing the information entered, the following sign will appear on 
the screen. 

System File  Edit  Diagnosis  Window 
Patient Encounter1 

Date 09/28/95  Time 10:02  Status P 
Patient Name DOE 
SSN 000-00-2222 Sex M 

Provider 
First JOHN 
Age 30 

<Complaint> Acute abdominal pain     <Diagnosis> APPENDICITIS 
= One moment ===== 

AGE => 3 0 
SITE AT ONSET 
SITE AT PRESE 
NAUSEA 
APPETITE 

Calculating... 

<Treatment>- 

<Print> «Save» <Cancel> 

Figure 34.  Calculating Message 
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When the calculations are completed, the predicted diagnosis will appear in the <Assist> 
window (Figure 35) and the <Explanation> button will be enabled. 

System File Edit Diagnosis Window 
Patient Encounter1 

Date 09/28/95  Time 10:02  Status P 
Patient Name DOE 
SSN 000-00-2222 Sex M 

<Complaint > Acute abdominal pain 

— <Symptom> T' 

AGE 
SITE AT ONSET 
SITE AT PRESENT 
APPETITE 

45 
RIGHT LOWER Q» 
RIGHT LOWER oj 
DECREASED    » 

Provider 
First JOHN 
Age 30 

<Diagnosis> APPENDICITIS 

 <Assist>  

<Explanation> 
•<Treatment >- 

<Print > <<Save>> <Cancel> 

Figure 35.  Calculated Diagnosis 

The <Explanation> button can be selected after the diagnosis is computed. The <HOW> 
function lists the differences between signs and symptoms of the selected diagnosis and the 
NCAMD predicted diagnosis.  Select <OK> to close the window. 

System  File  Edit  Diagnosis  Window 
Patient Encounter= 

Date 09/28/95  Time 10:02  Status P 
Patient Name DOE 

Provider 
First JOHN 

SSN 000 

<Compla 

AGE 

:Diseases on File= 

APPENDICITIS 
NONSPECIFIC ABDOMINAL PAIN 

< HOW  > 

< VIEW > 

< OK  > 

<Prmt> «Save» <Cancel> 

Figure 36.  Explanation Window 
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The <VIEW> function can be used for two purposes: to display the disease description 
or to capturing treatment information for the treatment field. 

Disease Description 

Appendicitis (APPEND), Acute appendicitis 

Acute appendicitis results from a bacterial invasion of the appendix with 
inflammation. Incidence is highest in adolescents and young adults, peaking between ages 
15 and 24. Typically the pain initially is poorly localized in the periumbilical region. 

1. TREATMENT PROTOCOL AT A GLANCE. (see detailed discussion of treatment below; this 
section is for quick reference). Definitive treatment of acute appendicitis is surgical. 
Notify command of need for immediate MEDEVAC.  The treatment goals are pending MEDEVAC. 

A. Place patient at strict bed rest with head of bed slightly elevated. Monitor vital 
signs, fluid intake and output, and progress of symptoms and examination. 

«OK» 

Figure 37.  View Treatment Explanation 

The next step is to enter treatment information. This can be either typed directly into the 
treatment window, or taken from the disease file. 

System File  Edit  Diagnosis  Window 
= Patient Encounter1 

Date 09/28/95  Time 10:02  Status P     Provider 1 
Patient Name DOE First JOHN 
SSN 000-00-2222 Sex M       Age 30 

<Complaint>   Acute Abdominal Pain  <Diagnosis> APPENDICITIS 

<Symptom> •<Assist>■ 

APPENDICITIS 
NONSPECIFIC ABDOMINAL PAIN 

■<Explanation>- 
<Treatment> 

Enter treatment in here 

<Prmt> «Save>> <Cancel> 

Figure 38.  Treatment Information 
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Figure  39  shows  data being  captured while using the <Edit>  function  and the 
<Explanation> <View> function. 

System           | File Edit Diagnosis          | Window | 
Undo 
Redo 
Cut 
Copy 
Paste 

Disease Description 

1.  TREATMENT PROTOCOL AT A GLANCE.  Definitive treatment of acute appendicitis is 
surgical.  Notify command of need for immediate MEDEVAC.  The treatment goals are 
pending MEDEVAC. 

A.  Place patient at strict bed rest with head of bed slightly elevated. Monitor 
vital signs, fluid intake and output, and progress of symptoms and examination. 

« OK » 

Figure 39.  Edit Treatment Information 

The information captured can then be pasted and edited in the patient encounter by using 
functions from Edit menu. 

System File Edit Diagnosis Window 
=Patient Encounter= 

Date 09/28/95  Time 10:02  Status P     Provider 1 
Patient Name DOE First JOHN 
SSN 000-00-2222 Sex M        Age 30 

<Complaint>  Acute Abdominal Pain  <Diagnosis> APPENDICITIS 

<Symptom>- 

AGE => 30 

■<Assist>- 

APPENDICITIS 
NONSPECIFIC ABDOMINAL PAIN 

■<Explanation>- 
<Treatment> 

Notified the command of the need for immediate MEDEVAC. 
The treatment goals are pending MEDEVAC. Placed patient at 
strict bed rest with head of bed slightly elevated.  Monitoring 
vital signs, fluid intake and output, and progress of symptoms 
and examination. 

<Print> «Save» <Cancel> 

Figure 40.  Treatment Information 
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The encounter is completed and can be saved and/or printed.  Use <Cancel> to exit. 

System File  Edit Diagnosis Window 
Patient Encounter1 

Date 09/28/95  Time 10:02  Status P 
Patient Name  DOE 
SSN 000-00-2222 Sex M 

Provider 
First JOHN 

Age 30 

<Complaint > Acute Abdominal Pain <Diagnosis> APPENDICITIS 

<Symptom>- 

AGE => 30 

■<Assist>- 

APPENDICITIS 
NONSPECIFIC ABDOMINAL PAIN 

■<Explanation>- 
•< Treatment >- 

Notified the command of the need for immediate MEDEVAC .. 

<Prmt > «Save» <Cancel> 

Figure 41.  Save Encounter 

When the <Print> option is selected, a print dialog box (Figure 42) will appear. The 
information may be copied to a file or sent directly to the printer. To save an encounter to a file, 
select the File (*) option in the print encounter box, then enter the name of the report, and select 
the <OK> button. To send an encounter to the printer, select Printer (*) option in print 
encounter box, then <OK>. 

System File Edit Diagnosis Window 
- Patient Encounter1 

Date 09/28/95  Time 10:02  Status P 
Patient Name DOE 
SSN 000-00-2222 Sex M 

Provider 
First JOHN 
Age 30 

<Complaint> Acut ======= Print Encounter  ITIS 
st> T»—| 

1 Print Encounter to:   (• ) File 
( ) Printer AGE 

SITE AT ONSET 
SITE AT PRESEN 
NAUSEA 
APPETITE 

NAL PAIN» 

1 
T 
1 

Filename: REPORT-.TXT 

< OK >    <Cancel> 

<Prmt> «Save»   <Cancel> 

Figure 42.  Print Encounter 
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4.4.3 Disease/Treatment Lookup. This option allows the user to review the disease description 
and treatment protocol. The Disease/Treatment Lookup file contains 7 sections: Disease 
Description, Discussion, Differential Diagnosis, Treatment of Disease, Usual Course with 
Treatment, Complications, and Management of Complications. When this option is selected from 
the Diagnosis Menu the following popup list of descriptions or treatment information will 
appear. To end this process select <Quit> or to view any particular disease or treatment 
description simply selected the disease on the scrolling window, then select the <View> button. 

DISEASE/TREATMENT REFERENCES 

ACUTE PANCREATITIS 
ANGINA 
APPENDICITIS 
CHEST INFECTION 
CHOLECYSTITIS 
INGUINAL HERNIA 
NONSPECIFIC ABDOMINAL PAIN 

<Select>     <View>   <Quit> 

Figure 43.  Disease Table Reference 

4.4.4 SF600 Report. This option extracts the encounter data and compiles it into the SF600 
report format. The report can either be sent to a printer or stored in a file. The <Edit> option 
allows this report to be modified. 

System                   File                         Edit Diagnosis Window 

Register Patient 
Encounter 
Disease/Treatment Lookup 
SF600 Report 
Training Mode 

Figure 44. SF600 Report 

The SF600 Report option allows the user to fill in social security number, last name, first 
name and/or encounter date. If any field is unknown leave it blank. The input process allows 
partial information to be entered. Use a question mark "?" for a single unknown character. To 
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look up the existing patient encounter in the system, at least one field must be entered.   Select 
<OK> when finished, <Browse> to see the entire patient encounter listing, or <Cancel> to quit. 

Convert Encounter to SF600 Report 

Social  Security: 
Lastname: DOE 
Firstname: 
Encounter Date: /     / 

«  OK  »     <BROWSE>     <CANCEL> 

Figure 45.  Create SF600 Report 

A candidate list will then appear for the user to either <Select> a patient from the list or 
to <Cancel> the process. 

Patients in File 

[0000002222]   Doe,   John 

< Select  >   <Cancel> 

Figure 46. Patient Candidate List 

After the correct patient is selected, the system will search the encounter for a specified 
date.  Select <OK> to continue or <Cancel> to quit. 

Patient:   000002222 
Date:        9/29/95 

000002222 14:44:38       Acute Abdominal   Pain 

<  OK  > <CANCEL> 

Figure 47. Patient Data Screen 
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The Report Editing screen appears after the report is generated. Read it carefully and 
make necessary changes. Press <Save> to save the change, <Print> to output the report, 
<Cancel> to quit out the option. The output device can be either a file or printer. If choosing 
a <FiIe>, remember to enter the filename at the filename field. Select <OK> when sending the 
report to a device, or <Cancel> to abort the process. See Appendix A for editing commands. 

Report Editing 

This 30 Years old male presents with pain over his whole chest, which radiates 
to the left arm. The pain began about 2 days to a week ago and was gradual in onset. 
The patient has been in continuous pain. He describes the pain as sharp. Numbness 
is absent. The pain is moderate in severity and seems to be getting worse since it 
began. By history, coughing makes the pain worse, and pentaphenabarbitol and gin 
seems to make the pain better. The patient reports dyspnea associated only with this 
illness. The patient has no cough. Sputum is absent. Orthopnea is absent. 
Paroxysmal nocturnal dyspnea is absent. 

< Print >    < Save >   < Cancel > 

Figure 48. Report Editing Screen 

4.4.5  Training Mode.  When this option is selected, information is stored in a temporary file 
and not in the permanent database. 
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Section 5 Appendices 

A. Text Editor Commands      Al 
B. Encounter Forms   B1 
C. Installation Guide    Cl 
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Appendix A:  Text Editor Commands A-l 

Cursor Movements 

Right Arrow Move one character to the right 

Left Arrow Move one character to the left 

Up Arrow Move up on line 

Down Arrow Move down one line 

Home Move to the end of the line 

End Move up one window-full of text 

PgUp Move down one window-full of text 

Ctrl + Right Arrow Move one word right 

Ctrl + Left Arrow Move one word left 

Ctrl + Home Move to the beginning of text 

Ctrl + End Move to the end of text 

Select Text with Key Board 

Shift Arrow Keys Select a range of characters 

Shift Arrow Keys Select a range of words 

Shift + Ctrl + Arrow Select from cursor to beginning of text 

Shift + Ctrl + End Select from cursor to end of text 

Ctrl + A Select entire document 

Select text with Mouse 

Drag Select a range of characters 

Double-click Select a range of words 

Double-click and drag Keys Select from cursor to beginning of text 

Triple-click Select from cursor to end of text 

Triple-click and drag Select entire document 



Appendix A:  Text Editor Commands A-2 

Delete and Replace 

Place cursor to the right of the character, press 
Backspace, or place cursor at the character, press Delete 

Place cursor anywhere in word, press Ctrl+Backspace 

Select and press Backspace 

Select text to be replaced, type new text (or Paste) 

Delete a characters 

Delete a words 

Delete a selection 

Replace existing text 

Cut, Copy and Paste 

Select the text, press Ctrl+X or use Cut in the Edit 
menu 

Select the text, press Ctrl+C or use Copy in the Edit 
menu 

Press Ctrl+V or use Paste in the Edit menu 

Select text, press Ctrl+V or use Paste in the Edit menu 

Cut Text 

Copy Text 

Delete a selection 

Replace existing text 



Appendix B:  Encounter Forms B-l 
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Appendix C:  Installation Guide                                                                                            C- 

r 

This Appendix contains the listings of the four files used in the installation of the CAMD 
system;      CAMDREAD.DOC,   INSTALL.BAT,   INSTALL.TXT   and   CAMD.BAT.      The 

? CAMDREAD.DOC   contains   the   instructions   for   installing   the   CAMD   system.      The 
INSTALL.BAT is the batch file that installs the CAMD system from the three floppy disks to 
the hard drive. The INSTALL.TXT contains the messages that are displayed during installation 
The CAMD.BAT is the batch file that starts the CAMD system once it has been installed. 

CAMDREAD.DOC. The CAMD system needs 20 Mega bytes on a hard drive.  This 

Computer-Assisted 
Medical Diagnosis 
Installation. 

package includes a 3.5" high density (1.44M) floppy disks. 

To install the CAMD system, complete the following: 

1. Put CAMD INSTALLATION DISK into disk drive (A or B) 

2. Goto floppy disk drive. Type A: or B: 

3. Type> INSTALL -option d: 

option:        -a extract all 
-d only extract database. 
-u  only extract utility files. 
-x  only extract excutable file, 

drives:        d:  destination drive (c: or d:) 

EXAMPLE:        INSTALL -a c: 

4. In the root directory (C:\) modify or add the FILES and SHELL 
commands in the CONFIG.SYS file. The FILES command should 
be set to 50 or more (FILES=50). The SHELL command should 
read: 

SHELL=COMMAND.COM /P /E:512) for DOS 3.2 + 
or        SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and 

below. 

5. Reboot the system. 

> 
6. At the DOS prompt type C:\CAMD>CAMD. 

» 7. The password is CAMD. 
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INSTALL.BAT 

CAMD Installation 
batch file. 

echo off 
rinstall.bat hll@nhrc 
if "%2"=="" goto LI 
els 
type install.txt 
pause 
els 
if exist %2\camd goto camd 
md %2\camd 
:camd 
cd %2\camd 
if "%l"=="-a" goto all 
if "%l"=="-d" goto data 
if "%l"=="-u" gotoutil 
if "%l"=="-x" gotoexe 
goto LI 
:all 
camd.exe -d %l\camd 
goto done 
:data 
camd.exe -d data\*.* %2\camd 
goto done 
:util 
camd.exe -d util\*.* %2\camd 
goto done 
:exe 
camd.exe -d bin\*.* %2\camd 
:done 
els 
echo Remove Disk from Drive 
echo CAMD installation completed!!! 
goto end 
:L1 
echo format: 
echo option: 
echo 
echo 
echo 
echo 
echo EXAMPLE: 
:END 

INSTALL -option d: 
-a extract all 
d  only extract database, 
u  only extract utility files, 
x  only extract excutable file, 
d: destination drive (c: or d:) 

INSTALL -a b: c: 
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